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1. Introduction
This Deployment Guide will guide the installer through the process of installing, configuring, and adding a 
SmartControl 14 (SSC-0014) controller. 

Before You Begin
Read through this document in its entirety and ensure that the following required items are available: 

....................................................................................................SmartControl 14 (SSC-0014) controller  

.................................................................................................................Unique ID (UID) of the controller 
(located on the bottom of the unit)

..........................Savant Host (Smart or Pro Host) licensed and running da Vinci 7.0 or higher 

...........................................................................Savant Development Environment (SDE) MacBook® 
(with RacePoint Blueprint® da Vinci 7.0 or higher installed)

..................................................................................Ethernet network meeting Savant requirements 
(see Network Requirements)
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2. Deployment Steps Checklist
Follow these steps to successfully deploy the SmartControl 14 (SSC-0014) controller.  
This page can be used as a checklist to record which steps have been completed.

1. Review the SSC-0014 Connections .......................................................................... and Controls 
See SmartControl 14 Overview

2. ........................................................................................................................................Mount Controller 
See Installation

3. ..................................................................................Wire Controller to Savant Controller System 
See Wiring and Connections

4. ......................................................Add the SSC-0014 to a RacePoint Blueprint configuration 
See RacePoint Blueprint Configuration

5. ................................................................................................Upload Configuration to Savant Host 
See Upload Configuration
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3. SmartControl 14 Overview

Box Contents and Specifications
Refer to the Quick Reference Guide for this product located on the Savant Customer Community for Box 
Contents and Specifications

Front Panel

A Reset Button Press and hold for 5 seconds while powered On to clear network 
settings. Status LED will blink rapidly when reset is complete.

B Status LED

Blinks Once: No IP Address
Blinks Twice: Waiting for Host Connection
Blinks Three Times: Host Connection Lost
Solid: Connected to Host
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Rear Panel

A Ethernet
10/100 Base-T auto-negotiating port with Link/Activity LEDs:
8-pin RJ-45 female.
See items B and C for LED functionality.

B Link LED
Off: Ethernet link is not established.
Green Solid: Ethernet link is established.
Green Blinking: Ethernet activity is occurring.

C Data Rate LED Off: 10 Mbps data rate
Green: 100 Mbps data rate

GPIO (General Purpose Input and Output Ports)
9-pin Screw Down Plug-in Connector. See GPIO Wiring for pinouts.
GPIO (General Purpose Input and Output Ports)
9-pin Screw Down Plug-in Connector. See GPIO Wiring for pinouts.

D GPIO Input
When configured as an input, the processor will look for a low (<0.8V 
DC) or high (>2.4V DC ) state.
Minimum 0V DC / Maximum 12V DC

GPIO Output When configured as an output, the port provides a binary output of 
0-12V DC 150mA max.

Normally Open / Normally Closed - Relays
6-pin Screw Down Plug-in Connector (Right 3 Pins)
See Relay Wiring for pinouts.

Normally Open / Normally Closed - Relays
6-pin Screw Down Plug-in Connector (Right 3 Pins)
See Relay Wiring for pinouts.

E

Relay

Dry contacts (open/closed) to control devices requiring basic on/off 
operation. DC Voltage
Max: 30V DC 1A
1-3: 9-pin Screw Down Plug-in Connector
4-5: 6-pin Screw Down Plug-in Connector
6-7: 6-pin Screw Down Plug-in Connector

F Input Power 12V DC 1.6A - Connect to included power supply.

G Cable Lance Use with included cable tie to secure power supply connection.
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4. Installation
The SSC-0014 should be located in a place that is dry, well ventilated, and out of direct sunlight. 

Mounting Plate Installation 
A mounting plate (074-0577-xx) is supplied with the SSC-0014 controller. This mounting plate is used to mount 
the controller to a wall or existing structure. To mount the controller, follow the instructions below.

1. Position the mounting plate onto the wall where the controller will be located. Position the bracket so the tabs 
that hold the controller are positioned horizontally.

2. Mark the two mounting holes on the wall. 
3. Install wall anchors and screw mounting plate to the wall.
4. Snap the SSC-0014 controller into the bracket so the tabs on the mounting bracket seat into the slots on the 

side of the controller.

Rack or Cabinet Installation
When mounting in a rack or cabinet, the controller should be set on a solid, flat, level surface.

The next step is to connect the required ports. Refer to the Wiring and Connections section below.
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5. Wiring and Connections
Refer to the diagrams below when making connections.

Power and Ethernet

1. Connect RJ-45 Cat 5/5e/6 Ethernet cable from Ethernet port to the local network switch.
2. Plug the supplied power supply from the 12V DC port to a 120 VAC surge protected outlet.

GPIO Wiring
General Purpose Input/Outputs (GPIO) are binary I/O ports used on Savant® controllers to trigger an action within 
the system.  Events can control a device, such as turning on an amplifier (output) or detecting a state change for a 
device (input) to perform a workflow.  Pins 1-9 are used for input or output depending on configuration.

GPIO 1/2/3/4/5/6/7
9-pin Screw Down Plug-in Connector

GPIO Pull Down Resistor Usage (Option)
The GPIO pins are by default configured as inputs and pulled high to 12V while the host is booting up. To pull the 
GPIO signal low during a host reboot and/or a power cycle, a 1k ohm resistor can be connected between a GPIO 
pin and ground (GND). Doing this will keep the GPIO output below 0.8V while host is rebooting. 

Note: This functionality is supported on all 
GPIO Ports (1-7)
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Relay Wiring
Relays are used when a contact closure (normally open or normally closed) is needed to activate a device such as 
raising or lowering shades, opening or closing a gate, etc. 

Relays 1/2/3
9-pin Screw Down Plug-in Connector

Relays 4/5
6-pin Screw Down Plug-in Connector

Relays 6/7
6-pin Screw Down Plug-in Connector
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Making Connections
1. Remove Power if power is applied.
2. Pull to remove the terminal block from the rear of the controller.
3. With a small flat bladed screwdriver, turn the screws on the top of connector counterclockwise until the silver 

crimps in the front of the connector opens enough to slide the wires into the square slots.
4. Insert one of the stripped wires from the device being controlled into its respective slot in the connector. Refer 

to the diagrams.
5. Turn the screw clockwise until the screw tightens around the wire. Tug on the wire a bit to verify it is installed 

securely. Do not allow more than 1/2 inch of stripped wire exit from the rear of the connector.
6. Repeat for each wire till all wires are installed in that connector.
7. Repeat steps above for all connectors as required.
8. Plug terminal blocks back into rear of the controller.
9. Reapply power. 
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6. RacePoint Blueprint® Configuration
Add the SmartControl 14 controller to the configuration

1. From the RacePoint Blueprint menu bar, open the Component Library.
View > Show Component Library.

2. Enter SSC-0014 in the search box.
3. Select the SSC-0014 from the Component Library and drag it into one of the zones/rooms.

Note: Controllers are typically added to the Shared Equipment Zone but not required.

4. Drag the SSC-0014 into the RacePoint Blueprint layout window. If using an existing configuration, remove the 
component that the SSC-0014 is replacing.

5. Select the SSC-0014 and open the inspector.
View > Show Inspector

6. Enter the SmartControl 14 Unique ID (UID) for the SSC-0014 being used in the system. In order to be 
recognized by the Host, the UID located on the bottom of the SmartControl 14 is required within Blueprint.

7. Close the Inspector.
8. Connect the Ethernet port of the SSC-0014 to the local network device.

9. If any of the Control Ports on the SSC-0014 are to be controlling other equipment, the profiles for these 
devices can be found in the RacePoint Blueprint Component Library. Add this equipment and connect to the 
appropriate Control Port (GPIO, Relay).

Refer to the Relay and General Purpose Input/Output Profiles Application Note - 009-0482-xx on the 
Savant Customer Community for details on using these profiles.
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7. Upload Configuration
After the SSC-0014 has been added to Racepoint Blueprint and the configuration is complete, it needs to be 
uploaded to the host. 

1. Save the configuration.
Select File > Save from the Blueprint menu bar.

2. Select the Generate Services icon in the Blueprint toolbar. The State icon on the Blueprint toolbar will change 
to green indicating the services for the configuration were created.

3. To upload the configuration, select the Upload to Master icon from the Blueprint toolbar and send the 
configuration to the host.

4. In the Configuration must be saved dialog window that opens, read the dialog and select Save and Upload.

5. The System Monitor application will automatically open as shown below. Verify the path to the configuration 
file is correct. Select Upload when satisfied.

6. The configuration will now upload to the host. Once uploaded, the Savant Pro or TrueControl II App can now 
be opened and connected to the host
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8. Additional Documentation
Additional documentation is available on the Savant Customer Community.

• SmartControl 14 Smart Controller (SSC-0014) QRG - 009-1256-xx
• Relay and General Purpose Input/Output Profiles Application Note - 009-0482-xx
• Savant Controllers Family video in the Savant University pages
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Appendix A: Document Revision History

009-1272-01 - February 2016
Section Update

Rear Panel

• Removed Specifications Table 
• Updated Power Supply specifications
• Added Upload Configuration section
• Updated RacePoint Blueprint Configuration section

009-1272-00 - November 2014
Section Update

All Initial release of this Deployment Guide
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Network Requirements
Savant requires the use of business class/commercial grade network equipment throughout the network to ensure 
the reliability of communication between devices.  These higher quality components also allow for more accurate 
troubleshooting when needed.

Connect all Savant devices to the same local area network (LAN) or subnet as the host.  Savant recommends not 
implementing any type of traffic or packet shaping in your network topology for the Savant devices as this may 
interfere with performance.

Network Configuration
To ensure that the IP Address will not change due to a power outage, a static IP Address or DHCP reservation 
should be configured.  Savant recommends using DHCP reservation within the router.  By using this method, static 
IP Addresses for all devices can be managed from a single UI avoiding the need to access devices individually.

Setting DHCP reservation varies from router to router. Refer to the documentation for the router to configure 
DHCP reservation.

Network Changes
Savant recommends performing one of the following steps to refresh the IP connection after connecting to a new 
network, changing routers, or if the IP Address range is changed in the current router.  This will reset any IP 
connection and ensure that the SSC-0014 is communicating with the network correctly.

To Reboot the Controller:

• Cycle Power
Disconnect the controller from the AC power source for 15 seconds and then reconnect.

• Hot Plug the Ethernet (LAN) Connection
Disconnect the Ethernet (LAN) connection from the controller for 15 seconds and then reconnect.
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Important Notice

Disclaimer
Savant Systems, LLC. reserves the right to change product specifications without notice, therefore, the 
information presented herein shall not be construed as a commitment or warranty.

Savant Systems, LLC shall not be liable for any technical or editorial errors or omissions contained herein or for 
incidental or consequential damages resulting from the performance, furnishing, reliance on, or use of this 
material.

Patents
Certain equipment and software described in this document is protected by issued and pending U.S. and foreign 
patents.  

All products and services are trademarks or registered trademarks of their respective manufacturer. 

Copyright
This document contains confidential and proprietary information protected by copyright. All rights reserved. 
Copying or other reproduction of all or parts of this document is prohibited without the permission of Savant 
Systems.

Trademarks
© 2016 Savant Systems, LLC. All rights reserved. Savant, Savant App, Savant Host, Now You Can, RacePoint 
Blueprint, Single App Home, TrueCommand, TrueControl, and the Savant logo are trademarks of Savant Systems, 
LLC.

AirPlay, Apple, AirPort Express, AirPort Extreme, Apple TV, Apple Remote Desktop, FireWire, iMac, iTunes, iPad, 
iPad mini, iPad Air, iPhone, MacBook, Mac and OS X are trademarks or trade names of Apple Inc. iOS is a 
trademark of Cisco®. Android, Google, Google Play, and other Google marks are trademarks of Google, Inc. Wi-Fi 
is a registered trademark of the Wi-Fi Alliance®. HDMI® is a trademark of HDMI Licensing, LLC.

All other brand names, product names, and trademarks are the property of their respective owners.

Technical Support
Savant Systems, LLC is dedicated to providing prompt and effective support in a timely and efficient manner.

• To contact Savant Support, access the Savant Customer Community and enter a support Case ticket.

• To contact Savant Sales, visit Savant.com and select Contact Us to locate a local sales representative in your 
area.
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